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Introduction

ILB is a utility for building and editing Stamp and Sprite libraries.    These libraries are SPA format libraries
that are used with the Story Maker application.

A library can either contain stamps (individual pictures) or sprites (sets of pictures that when displayed in 
sequence animate the figure), but it can not contain both.    A library normally contains pictures on a 
particular topic or theme, such as Garden, Building or Sport; however you could create a library of your 
most frequently used figures.

This ILB (Image Library Builder) utility program is used for editing existing libraries or creating new ones.   
You can move stamps and sprites from one library to another, change the order they appear within a 
library, or import new stamps and sprites from picture files or from other applications via the Windows 
clipboard.    ILB is not a picture editor.    It has no tools for changing how a particular stamp looks.    Any 
such changes should be made using a separate painting program such as Windows Paintbrush.

To find out more about making libraries click on the appropriate subject area on the Contents page



Building new libraries

To make a new library click on the new button in the toolbar or select New from the File menu.

Libraries can either contain stamps or sprites, so when creating a new library you will be asked which 
type you want to make.    Stamp libraries are more straightforward than sprite libraries since each picture 
has only one frame, so if making a library for the first time it is easiest to start with those.

Having chosen the type of library you wish to build you will be presented with an empty window into which
you can put your stamps.    

Stamps can come from three sources:

1) Other stamp libraries (see Moving stamps between libraries)

2) Picture files (see Importing stamp and sprite files)

3) Other Windows applications via the Windows clipboard. (see Cutting and Pasting stamps and sprites)

You continue adding stamps to your library until you have as many in there as you wish.    It is best not to 
make the library too big since the user of such a library would have to wade through many pages to find 
the one they want.

If the stamps are not in the correct order, you can drag them around to reposition them (see Editing 
libraries for more information on doing this).

To be used by StoryMaker, a library must have a Topic picture.    This picture is displayed by StoryMaker 
when you choose which library (or Topic) you want to use.    A topic picture is 64 pixels wide by 64 pixels 
deep and can come from one of the usual three sources.    By convention this topic picture is on a yellow 
background with a thick red frame, so the best way to create one is by editing one from an existing library,
by transferring it to and from a Windows painting program. See Topic pictures for more information.

When satisfied with your library, select Save from the File menu (or click on the Save button in the 
toolbar) and give it a meaningful name.    Since the libraries have to be used with Windows 3.1, only 8 
characters can be used.

If you keep your library in the same directory as other StoryMaker libraries, StoryMaker should find it 
automatically so you can then check to see it is as you would like.

If the library is not as you wish, or you want to add more stamps or sprites to it then you can edit it again.   
See Editing libraries.



Editing libraries 

To edit an existing library select Open from the file menu or click on the open button in the toolbar.    From 
the open dialogue box choose the name of the library you wish to edit.    You can choose stamp libraries 
with a .ilb file extension or sprite libraries with a .slb file extension.

If you have recently edited the library it may also appear in the recent file list in the file menu.    The 
names of the four most recently edited libraries are remembered in this list.

Once loaded, the contents of the library are displayed in a window.    The stamps and sprites are always 
displayed actual size.    The stamps and sprites are displayed in the order they appear when used in the 
StoryMaker program, but instead of being displayed in pages they are displayed in a large scrollable 
window.    For sprite libraries, each sprite is displayed on a separate line, with all frames showing.    For 
sprites with many frames you will need to scroll sideways to see the last ones.    For stamp libraries the 
stamps are displayed next to each other on the same line up to the edge of the window, and then on 
following lines.    Resizing a stamp library window will reformat the stamps to fit.

The stamps and sprites are displayed inside a grey frame.    To select a particular stamp or sprite click on 
it.    The selected stamp will now be shown in a red frame.    Note that for sprites you select the whole 
sprite, not an individual frame.

A status bar at the bottom of the screen gives details about the selected stamp and library.    The topic 
picture for the library and library name are shown, together with the name of the selected stamp, a scaled 
picture of the stamp (or first frame of the sprite) and the width and height in pixels of the stamp (or frame 
of the sprite).

When a stamp is selected you can perform operations on it using toolbar buttons or menu items.    You 
can cut or copy it to the clipboard for transfer to another Windows application.    You can delete it (use the 
Delete stamp menu item or press the DEL key), and you can change its name.

You can reorder the stamps in the libraries by dragging them to different positions within the library.    
When you start to drag a stamp the cursor changes to indicate this is what you are doing.    As you move 
over another stamp a blue line is shown next to the stamp or above or below a sprite showing you where 
it will be inserted when you let go of the button.    If you cannot see enough of the library to drag it where 
you want you can open a second window on the library using New window on the window menu.    You 
can then drag the stamp from one window to another. 

In the same way you can drag stamps between libraries by opening two libraries and dragging a stamp 
from one window to another (see Moving stamps between libraries).

Hint:    When ordering stamps in a library it can be a good idea to put stamps of similar heights next to 
each other as this will ensure that the maximum number of stamps appears on each page when viewed in
StoryMaker.



Moving stamps between libraries

There are two ways of moving and copying stamps between libraries.    You can either drag them from 
one to the other or you can use the Cut, Copy and Paste tools.    Dragging them is the most flexible and 
intuitive method so is the recommended technique.

To move or copy a stamp to another library by dragging open both libraries - and make sure you can see 
enough of both windows - you may find it easiest to use the Tile command from the Windows menu.

Then, click on the stamp you want to move and without letting go of the mouse button drag it to the 
position in the other library window you want it to go.    As you start to drag the shape of the cursor 
changes to show you that you are moving.    You will also see a blue line appear between stamps or 
sprites to show you where the stamp you are moving will be inserted if you let go of the mouse button.

If you drag the stamp within the same library window (or another window onto the same library) then the 
stamp will simply move position within the library, whereas if you drag it to a different library it will make a 
copy of the stamp in the new library.    The arrow cursor is shown with a + sign next to it to indicate if it is 
copying the stamp.

If you want to make another copy of the stamp within the same library then hold down the CTRL key while
you are dragging.

If you want to move the stamp from one library to another, so that it is removed from the first library then 
hold down the SHIFT key while you are dragging.



Importing stamp and sprite files

You can import stamps and sprites from picture files and add them to your selected library.    You do this 
by clicking on the picture in the tool bar or with the Load stamps or Load sprite menu commands.

Pictures can be in Windows bitmap format (.bmp) or PaintSpa Plus (.pnt) picture format.    If you have a 
picture in a different format you will have to load them into a painting program that understands that 
format and copy them into the stamp libraries using cut and paste.

A picture file can contain a number of stamps or a single sprite (you can only load sprites into sprite 
libraries).

If your picture file only contains one stamp then loading it is straightforward, but if you have than one 
stamp within a picture file then the way they are laid out is quite important, so that ILB can work out how 
many stamps there are in the file.    See Stamp format for more details on this.

Similarly the layout of the frames of a set of sprite pictures is also important so that they appear in the 
correct order. See Sprite format for more details on this.

Imported stamps and sprites are inserted into the library immediately following the currently selected 
stamp, so you may need to reposition them once they are inserted.



Cutting and Pasting Stamps and Sprites

You can cut and paste stamps and sprites from one library to another, or to and from a different Windows 
application via the clipboard in the traditional Windows manner.

To copy a stamp or Sprite to the clipboard select Cut or Copy from the Edit menu (or use the buttons on 
the toolbar).    If you select Cut, then the stamp will be removed from the current library as well.

If you copy a Sprite to the clipboard then all the frames of the sprite are copied as one long thin picture 
(including the frame border).

Stamps copied from a library can be pasted into other Windows applications that can use Windows 
bitmaps (for example: painting or desktop publishing applications).    Note that ILB also puts the name of 
the stamp on the clipboard (e.g. "bench", "rabbit", "monster with two heads"), so applications which 
normally expect text (e.g. Microsoft Word) may well insert this name when you select Paste.    Within such
applications use Paste special to insert the bitmap image.

To paste a bitmap image into a library select Paste from the Edit menu or use the Paste button in the 
toolbar.

A bitmap image to paste is treated like an image being imported from a file.    That is, it can contain a 
number of stamp pictures or a single sprite picture.    If you are copying more than a single stamp image 
then please see Stamp format or Sprite format for more details on how the stamps or sprite images 
should be laid out.

When pasting an image that has been cut from a different library you will find that ILB remembers the 
name of the stamp.    If, however, you are pasting an image from a different application then you will have 
to give each of the pasted stamps a name.

Stamp libraries use a standardised colour palette which provides a range of 256 colours across the whole
spectrum.    All stamps and sprites pasted to the libraries are therefore converted to use this palette.    This
change is normally imperceptible unless the image being imported has a very specialised palette, such as
many shades of red.    Other Windows applications will do the same when using stamps cut from a stamp 
library.    However some do it better than others!    In particular Windows Paintbrush does not always seem
to be very good at preserving the colours and can suddenly decide to convert the picture to use 16 
colours only for no apparent reason.    If you have access to a better painting program it is suggested that 
you use that for editing the stamps.



Stamp format

Stamps that are being imported from a file or pasted from a different Windows application must be laid out
in a special way so that ILB can distinguish between them.    This only applies where a file contains more 
than one stamp.

The stamp images are scanned from left to right and top to bottom.    Rows of images must be separated 
by a horizontal line of white all the way across the picture.    Each image within a row must be separated 
from the next by at least a single pixel width vertical line of white.

Images may have frames around them which can be of any colour.    If when scanning the picture for 
images ILB comes across a rectangle of a solid colour it will assume that the image has a frame around it 
and will take the area inside the rectangle as the whole image.    This can be useful when you want to 
make a single stamp of several detached objects (such as stars at the end of a magic wand).    
Occasionally it can be troublesome when the image itself has a frame.    If in doubt draw a frame around 
the image.

If you do put a frame around your image make it as tight as possible around the image in order to keep 
the size of the libraries down.

White is always taken as a background colour, so any white inside your picture will be used as a 
transparent colour when the image is drawn in StoryMaker.    This can be a problem if you wish to have 
white as a solid colour within your picture.    There are two solutions.    Firstly, substitute a very light grey 
for white within your picture.    This is what we do ourselves and when it is used it is not possible to tell the
difference.    The alternative is to put a frame around the image and fill the areas you wish to be 
transparent with a colour that is not used within your picture.    Once the picture has been imported into a 
library you can use Set transparent colour from the stamp menu and set this colour to be the 
transparent colour for the image.



Sprite format

Sprites that are being imported from a file or pasted from a different Windows application must be laid out 
in a special way so that ILB can distinguish between each frame of the sprite.    You can only import or 
paste one sprite at a time - all images within the picture are assumed to be frames of the same sprite.

Each frame of the sprite should have a border (frame) around it.    Each frame in the sequence is 
separated from each other with a single pixel width vertical line of the frame colour as shown above.

If your sprite is too wide for the screen then you may prefer to split it across two or more rows.    Each row 
must be separated by a horizontal line of white all the way across the picture.    

To save storage space within the library the width of each frame does not have to be the same.    You can 
remove areas of white from the right hand edge of the frame as in the example below.

You should not remove areas of white from the left of images as otherwise the sprite will appear to jump 
around.

The "hot spot" for the sprite is taken to be the centre of the first frame of the sequence.

White is always taken as a background colour, so any white inside your picture will be used as a 
transparent colour when the image is drawn in StoryMaker.    This can be a problem if you wish to have 
white as a solid colour within your picture.    There are two solutions.    Firstly, substitute a very light grey 
for white within your picture.    This is what we do ourselves and when it is used it is not possible to tell the
difference.    The alternative is to fill the areas you wish to be transparent with a colour that is not used 
within your picture.    Once the picture has been imported into a sprite library you can use Set 
transparent colour from the stamp menu and set this colour to be the transparent colour for the sprite.

Beware!    Creating sprites is long and hard work!

If you have sprites from other applications such as Animated GIF files from the internet you will need to 
convert them to the above format.    Using a tool such as the shareware program "GIF Construction Set" 
you can extract each frame of the image and paste them together in the format described above using a 
suitable painting program.



Topic Pictures

A topic picture is a picture 64 pixels wide by 64 pixels high that is used by the StoryMaker program when 
displaying an index to the libraries on the disk.

Each library must have a topic picture.    By convention they are on a yellow background with a thick red 
frame so you may find it best to use an existing one as a starting point.    You can copy and paste the topic
picture from the topic menu.    You can also import it from a file.

If you make the topic picture too big then it will be cropped by StoryMaker.



Toolbar

    Make a new library

    Open a library

    Save a library

    Cut a stamp/sprite to the clipboard

    Copy a stamp/sprite to the clipboard

    Paste a stamp/sprite from the clipboard

    Load a stamp/sprite from a file



File menu commands

New Creates a new library.
Open Opens an existing library.
Close Closes an opened library.
Save Saves an opened library using the same file name.
Save As Saves an opened library to a specified file name.
Exit Exits ILB.



Edit menu commands

Cut stamp/sprite Cuts a stamp or sprite to the clipboard.
Copy stamp/sprite Copies a stamp or sprite to the clipboard.
Paste stamps/sprite Paste a number of stamps or a sprite from the clipboard.



Stamp menu commands

Load stamps Load stamps from a file.
Rename stamp Change the name of a stamp.
Delete stamp Remove a stamp from the library.
Set transparent colour Set the transparent colour for a stamp



Sprite menu commands

Load sprite Load a sprite from a file.
Rename sprite Change the name of a sprite.
Delete sprite Remove a sprite from the library.
Set transparent colour Set the transparent colour for a sprite



Topic menu commands

Copy topic picture Copy the topic picture to the clipboard.
Paste topic picture Paste a topic picture from the clipboard.
Load topic picture Load a topic picture from a file.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
libraries in the ILB window:

New Window Creates a new window that views the same library.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with ILB: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of ILB.

 New library

Use this command to create a new library.    Select the type of new library you want to create in the File 
New dialog box.    You can create Stamp libraries or Sprite libraries.

You can open an existing library with the Open library command.



New library dialog box

You can create stamp libraries or sprite libraries.    Choose which type of library you want to have.



 Open library

Use this command to open an existing library in a new window.    You can have a number of libraries open
at one time.    Use the Window menu to switch among the multiple open libraries.    See Window 1, 2, ... 
command.

You can create new libraries with the New library command.



File Open dialog box

The following options allow you to specify which library to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Stamp library (.ilb extension)
Sprite library (.slb extension)

Drives
Select the drive in which ILB stores the library that you want to open. 

Directories
Select the directory in which ILB stores the library that you want to open.



Close

Use this command to close all windows containing the active library.    ILB suggests that you save 
changes to your library before you close it.    If you close a library without saving, you lose all changes 
made since the last time you saved it.    Before closing an untitled library, ILB displays the Save As dialog 
box and suggests that you name and save the library.



 Save library

Use this command to save the active library to its current name and directory.    When you save a library 
for the first time, ILB displays the Save As dialog box so you can name your library.    If you want to 
change the name and directory of an existing library before you save it, choose the Save As command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    ILB adds the 
extension you specify in the Save File As Type box which will be appropriate for the type 
of library being saved.

Drives
Select the drive in which you want to store the library.

Directories
Select the directory in which you want to store the library.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



 Save As

Use this command to save and name the active library.    ILB displays the Save As dialog box so you can 
name your document.    

To save a library with its existing name and directory, use the Save command or click on the Save button 
in the toolbar



Exit

This button takes you out of ILB back to Windows.    You will be asked if you want to save changes made 
to any open library.



Window 1, 2, 3, 4 command

Use the numbers and filenames listed at the bottom of the File menu to open the last four libraries you 
closed.    Choose the number that corresponds with the library you want to open.    Stamp libraries are 
listed with a .ilb file extension and sprite libraries with a .slb extension.



 Cut stamp/sprite

The Cut command removes the currently selected stamp or sprite from the active library and places it on 
the clipboard.    It can then be pasted into a different library or alternative Windows application. See 
Cutting and Pasting stamps for more details.

Cutting data to the clipboard replaces the contents previously stored there.



 Copy stamp/sprite

The Copy command copies the currently selected stamp or sprite from the active library to the clipboard.   
It can then be pasted into a different library or alternative Windows application. See Cutting and Pasting 
stamps for more details.

Copying data to the clipboard replaces the contents previously stored there.



 Paste stamps/sprite

The Paste command takes the contents of the clipboard and pastes them into the active library.    See 
Cutting and Pasting stamps for more details on the bitmap image format of stamps and sprites on the 
clipboard.



 Load stamps

The Load stamps command imports stamps from a picture file and places them in the active library, 
immediately following the currently selected stamp.    The picture can be in Windows Bitmap (.bmp) or 
PaintSpa Plus (.pnt) picture formats.

See Importing stamp and sprite files for more details on importing stamps from a picture file.



 Load sprite

The Load sprite command imports a sprite from a picture file and places it in the active library, 
immediately after the currently selected sprite    The picture can be in Windows Bitmap (.bmp) or PaintSpa
Plus (.pnt) picture formats.

See Importing stamp and sprite files for more details on importing sprites from a picture file.



 Rename stamp

The Rename stamp command lets you change the name of the selected stamp in the library.    All stamps 
should be given a name such as "Dog", "Cat", "Giraffe" etc. as this is used by the StoryMaker program



 Rename sprite

The Rename sprite command lets you change the name of the selected sprite in the library.    All sprites 
should be given a name such as "Rain", "Plane" or "Whizzy thing" etc. as this is used by the StoryMaker 
program



 Delete stamp

The Delete stamp command deletes the selected stamp from the active library.    

You are asked to confirm that this is what you want to do.



 Delete sprite

The Delete sprite command deletes the selected sprite from the active library.    

You are asked to confirm that this is what you want to do.



Set transparent colour

The Set transparent colour command is used for changing the see-through colour of the stamp or sprite.

Normally white is used as the transparent colour but if your stamp contains white as part of the picture 
then either you need to recolour the picture, replacing white by a very light grey, or choose a different 
colour to be transparent.

After selecting this command from the menu, the cursor changes to a pipette.    The colour you click on 
with the pipette will be used as the transparent colour for the selected stamp.

Stamps are always rectangular so should you wish to use a colour other than white for the stamp it is best
to draw a frame around the stamp and fill all the background areas with the colour you wish to be 
transparent.



 Copy topic picture

The Copy topic picture command copies the topic picture for the active stamp or sprite library to the 
clipboard.    It can then be pasted as a topic picture for a different stamp library or into a windows painting 
program for modification.



 Paste topic picture

The Paste topic picture command pastes a bitmap image from the clipboard as the topic picture for the 
active stamp or sprite library.

Topic pictures must be 64 pixels wide by 64 pixels high.    By convention they are on a yellow background 
with a thick red frame so the easiest way to create one is to use one from another stamp library as a 
starting point.



 Load topic picture

The Load topic picture command loads a bitmap image from a file as the topic picture for the active stamp
or sprite library.    The image can be in Windows bitmap (.bmp) or PaintSpa Plus (.pnt) format.

Topic pictures must be 64 pixels wide by 64 pixels high.    By convention they are on a yellow background 
with a thick red frame so the easiest way to create one is to use one from another stamp library as a 
starting point.



New window

Use this command to open a new window with the same contents as the active window.    You can open 
multiple library windows to display different parts or views of a library at the same time.    If you change 
the contents in one window, all other windows containing the same library reflect those changes.    When 
you open a new window, it becomes the active window and is displayed on top of all other open windows.

Having two windows for the same library can be useful when you want to re-order the stamps within a 
library, since you can then drag them from one part of the library to another.



Cascade

Use this command to arrange multiple opened windows in an overlapped fashion.



Tile

Use this command to arrange multiple opened windows in a non-overlapped fashion.    When copying 
stamps from one library to another having tiled windows is often the least confusing.



1, 2, ...

ILB displays a list of currently open library windows at the bottom of the Window menu.    A check mark 
appears in front of the library name of the active window.    Choose a library from this list to make its 
window active.



Index (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using ILB and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help

Use this command for instructions about using Help.



About ILB

Use this command to display the copyright notice and version number of your copy of ILB.



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the ILB window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open library window.    ILB determines which window is next 
according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    ILB determines which window is 
previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the    window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




